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Notice

The information in this document is subject to change without prior notice in order to improve 
reliability, design, or function and does not represent a commitment on the part of this company.

In no event will we be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use or the inability to use the product or documentation, even if advised of the 
possibility of such damages.

Copyright © 1997 - 2010 SoftLab-NSK Ltd.
All Rights Reserved.

No part of this reference manual may be reproduced or transmitted in any form or by any means 
without the prior written permission of this company.

Throughout this manual, we make reference to product names that are trademarks of other 
companies. We are using these names for identification purposes only, with no intention of 
infringement of the trademarks.

FCC Information

FCC ID: 

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 
against harmful interference in a residential installation.  This equipment generates uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications.  However, there is no guarantee that 
interference will not occur in a particular installation.  If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
Consult the dealer or an experienced radio/TV technician for help.

Shielded cables and I/O cards must be used for this equipment to comply with the relevant FCC 
regulations. Changes or modifications not expressly approved in writing by SoftLab-NSK Ltd. may 
void the user’s authority to operate this equipment.

Limited Warranty

Our company warrants this product against defects in materials and workmanship for a period of 
one year from the date of purchase.  During the warranty period, products determined by us to be 
defective in form or function will be repaired or replaced at our option, at no charge.  This warranty 
does not apply if the product has been damaged by accident, abuse, misuse, or as a result of service 
or modification other than by us.

This warranty is in lieu of any other warranty expressed or implied.  In no event shall we be held 
liable for incidental or consequential damages, such as lost revenue or lost business opportunities 
arising from the purchase of this product.
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Introduction

The document describes a work place for a video goal judge who 
operates with the «Forward Referee» system. 

The guide has the information on dealing with the FDReferee 
and RPMStorageManager applications included in the «Forward 
Referee» system.

The FDReferee application is used for:
marking important sport events (goal, violation etc.)  ●
when recording of the match is being implemented;
reviewing recording disputed moments at any time by  ●
video goal judge;
making a video report at the end of the match. ●

The RPMStorageManager application is used for working with 
storages, i.e.:

preparing storages for recording new match; ●
archiving, dearchiving and deleting of records of  ●
previous matches.
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General Scheme of Dealing with Applications Included into 
the Forward Referee System

 
Before match

 
Operator:
1. Launches the FDReplayVideoIn applications and starts recording of data into 
storages.
2. Launches the FDReferee application. 

 
During match

 
The match is automatically recorded into storages by means of the FDReplay-
VideoIn application. Operator does not participate here. 

Operator deals with the FDReferee application:
– marks interesting events during match;
– reviews disputable events of the match on request of video goal judge.

 
After match

 
Operator deals with the applications:
1. FDReplayVideoIn:

stops recording of data into storages; ●
stops work of the application.  ●

2. FDReferee:
creates video report with important events of the match; ●
stops work of the application.  ●

3. RPMStorageManager:
launches the application; ●
transfers records of the match from storages into archive; ●
stops work of the application. ●

This document provides with a detailed description of operator 
instructions given above.
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FDReferee Launch

To launch the application:

1. Turn on PC.

2. Wait till the pop-up message on launching of the PostPlay 

service appears above the  icon in the Windows taskbar 
notification area (usually located in the bottom right corner 
of your desktop).

Note: The PostPlay service and the PostPlay Indicator application are both 
automatically launched when Windows is started.
The PostPlay service and the PostPlay Indicator application are 
components that are necessary for working of the «Forward Referee» 
system.

3. Shortcuts of all necessary for the user applications 
(FDReferee components) will be placed on the desktop.

4. Double-click the VideoIn #1 shortcut (1).
1
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5. Click Start (2) in the FDReplayVideoin #1 window.

2

3 4

6. Minimize the FDReplayVideoin #1 window by clicking the 

 (3) or  (4) buttons located in the window title bar. 

The application continues working. The  icon (5) appears 
in the taskbar notification area. 

5

7. Double-click VideoIn #2 (6).
6
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8. Click Start (7) in the FDReplayVideoin #2 window.

7

8 9

Minimize the FDReplayVideoin #2 window by clicking the

 (8) or  (9) buttons in the window title bar. The 

application continues working. The  icon (10) appears in 
the taskbar notification area.

10

9. Double-click FDReferee (11).
11
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10. Either the Open Multiple Storages - FDReferee window or the 
main application window appears depending on the settings 
of the application. 
Click OK (12) if the Open Multiple Storages - FDReferee window 
appears.

12

A list of specified storages on your PC may differ from 
presented on the picture. It depends on the settings of the 
concrete system.
Usually storages are selected correctly when configuration 
of the system is being implemented and it is not required to 
change it.

11. The main FDReferee application window appears.
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Time and titles of preview windows may differ from 
presented on the picture. It depends on the settings of the 
concrete system.
Location and dimensions of preview windows can be 
adjusted.

12. Switch to the preview mode to display current video from 
cameras in preview window. Switching can be implemented:

using the  ● Ctrl+I keys combination; 
 

I

Ctrl Ctrl  

via the  ●  button located on the toolbar (1);
1

2

via the  ● View > Switch to Input Preview menu command (2).
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Main Application Window

1. Main Window Overview

3

4

2 1

5

6

7

Elements of the main application window:
(1) – main menu; ●
(2) – toolbar; ●
(3) – field with the current playing time; ●
(4) – elements that are used to display the information  ●
on the current position of record playback (detailed 
information is given below);
(5) – elements that are used to work with the events  ●
(detailed information is given below);
(6) – buttons that are used to move on recorded video  ●
material;
(7) – windows for reviewing video data received/ ●
recorded by different cameras.
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2. Displaying of the Current Video Record Position
The main application window displays the following information 
on the current position of a video record:

2

1

3

4

5

(1) is current position time; ●
(2), (3), (5) indicate playing time that corresponds to  ●
the current position;
(4) is the information on the current event (number  ●
and time of event mark).

3. Elements For Working With Events

3.1. General Information
An event is an important occurrence happened during any 
match that is specially marked by the operator.

The event can be marked either directly after it has happened or 
later using recorded material.

A list of marked events is displayed in the main application 
window in the form of the table.

1

2

The application provides a possibility of marking the events and 
assigning them to different types, for example, Goal or Viola-
tion. Events that have type are marked with different colors (1). 
Events without type specification are not coloured (2).
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«Special event» denotes an event that has type specification.

The name and the color of special events are user-specified.

3.2. Table With Events List
Every row of the table corresponds to the single event. Rows 
with events of the same type are marked with the same colour.

The following information on events is displayed in the table:
number of event is in the  ● # column;
the  ● Time column indicates event mark time in the pe-
riod_hh:mm:ss:frames format;
name of the event type ( ● Violation, Goal etc.) is displayed 
in the Event Title the column.

3.3. Current Event
Event selected in the event list becomes the current one. 
The number of this event is marked by green (1).

1

When an event is selected as the current one its frames are 
displayed in preview windows.

When an event is marked the current position automatically 
moves to the event time and marked event becomes the current 
one.

Let we select any event as a current one. Then we change 
current position and corresponding frame will be displayed in 
preview windows. Selected event remains a current one and you 
may return to its time mark by clicking «0».
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Double-click line with event to mark it as a current one. You can 
also move between events via the following keys:

PgUp ●  is used to move to the previous event and to 
select it as the current one;
PgDn ●  is used to move to the next event and to select it 
as the current one;
Backspace, End ●  is used to move to the last event and to 
select it as the current one. 
 

Backspace

End PgDn

PgUpHome
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Operator Actions During the Match

1. Marking of Event When It Happens

1.1. Marking of Event with Type Specification (Special Event)
The event can be marked in one of the following ways:

by using keyboard shortcuts: ●

Table 1. Keyboard Shortcuts
Shortcut Used to mark...

B Special event 1 (by default – Goal)
N Special event 2 (by default – Danger)
M Special event 3 (by default – Violation)
< Special event 4
> Special event 5

     
B N M < >

via the  ● Events > Mark Special Event N menu command, 
where N is the number of the special event.
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1.2. Marking of Event Without Type Specification
The event without type specification can be marked in one of the 
following ways:

by pressing  ● Space on the keyboard; 
 

 

by clicking the  ● Mark Event button (1) located in the main 
application window; 
 

1

 

via the  ● Events > Mark Event menu command. 
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Row with a new event will be added to the table list. Nothing 
will be specified in the Event Title column because the event was 
marked without type specification.

2. Editing of the Event

2.1. Editing of the Event Type
If the event is a current one right-click it in the list to edit its 
type. Select the Correct Current Event to Special Event X command in 
the context menu, where X is the number of special event type.

If the event is not the current one you may edit its type in one of 
the following ways:

by double-clicking it to mark as a current one. Then  ●
edit its type in the above described way (for the current 
events);
by right-clicking the event and selecting the  ● Edit This 
Event... command in the appeared context menu. Then 
select the type in the Title/Type drop down list of the Edit 
Event #N window, where N is the number of the event. 
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Click OK. 

2.2. Editing of the Event Mark Time
Complete the following steps if it is necessary to edit event mark 
time:

1. Switch to view storages mode:
using the  ● Ctrl+T keys; 
 

T

Ctrl Ctrl  

using the  ●  button located on the toolbar (1);
1

2

using the  ● View > Switch to View Storages menu command 
(2).

2. Select necessary event in the list by double-clicking it.

3. Frames of the selected event will be displayed in preview 
windows.

4. Select the moment corresponding to the new event mark by 
moving on the recorded video material.
Shifting can be implemented (detailed information is given 
in the table below):

using the buttons located in the main application  ●
window; 
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via keyboard keys;  ●
 

1

1 2 3 4 5 6 7 8 9 0

0

2 3

654

7 8 9

via the  ● Move menu commands. 
 

 

The table below describes the ways of moving on video material.
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Move menu 
command

Keyboard 
key

Button in the 
main applica-
tion window

Notes

Left one Step Moving one step left/right. 
Step is equal to 1/2 of frame by default. 
Step is adjusted in the interface configuration 
window when necessary. Right one Step

Left some Frames Moving some frames left/right.
Dealing with default settings we have 5-frames 
moving. 
Number of frames can be varied in the interface 
configuration window

Right some Frames

0 Seconds Back 0 Moving specified number of seconds back. 
There won't be recurring moving when the 
button will be pressed again.
For example, when 3 is pressed the frame 
located 3 seconds back from the event mark 
will be displayed in preview windows. If 0 is 
pressed then, another frame (corresponding to 
event mark) will be displayed.

1 Second Back 1

2 Seconds Back 2

3 Seconds Back 3

4 Seconds Back 4

5 Seconds Back 5

6 Seconds Back 6

7 Seconds Back 7

8 Seconds Back 8

9 Seconds Back 9

5. Complete one of the following actions to move event mark to 
the position selected on the previous step by:

pressing the «/» key on the keyboard;  ●
 

/

clicking  ● Correct (6) in the main application window;

6
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via the  ● Events > Correct Current Event menu command. 
 

 

3. Viewing of Event by Video Goal Judge
Video goal judge can review marked events in preview windows 
of the main application window (2) or on the additional monitor. 
Video material from currently selected preview window will be 
displayed on this monitor (1). When switching to another 
preview window the image will be also updated.

12

Workflow:

1. Switch to mode of viewing storages:
using a combination of the  ● Ctrl+T buttons; 
 

T

Ctrl Ctrl  

via the  ●  button located on the toolbar (1);
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1

2

via the  ● View > Switch to View Storages menu command (2).
2. Select necessary event in the list by double-clicking it.

3. Frames with the same time but recorded by different 
cameras will be displayed in preview windows.

4. Select preview window which data will be displayed on 
additional monitor in one of the following ways:

by clicking the preview window (in the main  ●
application window);
by using hot keys of the keyboard: ●

Table 2. Hot Keys
Hot key Used to select...

Z Camera 1
X Camera 2
C Camera 3
V Camera 4
A Camera 5
S Camera 6
D Camera 7
F Camera 8

    

A S D F

VCXZ
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by using commands of the  ● Edit menu. 
 

 

Preview window corresponding to the selected camera will 
be marked by green (3) in the main application window.

3

5. Use one of the following ways to scroll recorded video 
forward/back (the image will be scrolled in all preview 
windows simultaneously):

using keyboard keys: ●
 – right 1 step;
 – left 1 step;

 – right some frames;

 – left some frames; 
 



25

using the buttons located in the main application  ●
window:

 – right 1 step;

 – left 1 step;

 – right some frames;

 – left some frames.

4. Adding of the Event Mark to Recorded Material
Sometimes when period of the match is finished it may occur 
that some event wasn't marked. In this case video goal judge 
can view recording material, find necessary unmarked moment 
and asks operator to mark event.

Workflow:

1. Switch to viewing video from storage in one of the following 
ways:

by using the  ● Ctrl+T buttons; 
 

T

Ctrl Ctrl  

via the  ●  button located on the toolbar (1);
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1

2

via the  ● View > Switch to View Storages menu command (2).
2. Move on recorded material in storages select the event for 

being marked in one of the following ways:
by pacing (in case when time is unknown): ●

via keyboard keys: ●
 – right 1 step;
 – left 1 step;

 – right some frames;

 – left some frames;

via the buttons located in the main application  ●
window:

 – right 1 step;

 – left 1 step;

 – right some frames;

 – left some frames;
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moving to the period start via the  ● Move > Go to Period 
Begin menu command;
moving using a table with the list:  ●

double-click corresponding field in the table; ●
PgUp ●  is used to move to the previous event in the 
list and to select it as the current one;
PgDn ●  is used to move to the next event in the list 
and to select it as the current one;
Backspace, End ●  are used to move to the last event in 
the list and to select it as the current one; 
 

Backspace

End PgDn

PgUpHome

moving to the specified time:  ●
1. Select the Move > Go to Time... menu command or 

press the Ctrl+G combination.

G

Ctrl Ctrl

2. Specify the time where you want to move. Then 
click OK. 
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3. When necessary moment was specified create a new event in 
one of the following ways:

using the  ● Ctrl+R combination; 
 

R

Ctrl Ctrl  

using the  ● Create new event button located in the main 
application window.

4. New but untyped event will be added to the list.

5. Right-click the event and select the Edit Current Event X  
(X denotes number of the event type) command in the 
appeared window to specify the type.
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Operator Actions at the End of the Match

1. Stop of Match Video Recording
To stop process of match recording you should stop the 
FDReplayVideoin #1 and FDReplayVideoin #2 applications.

Workflow:

1. Click the  icon (1) in the taskbar notification area.

1

2. Click Stop (2) in the appeared window.

 2 3

3. Click Exit (3). The window will be closed.

4. Repeat actions 1–3 for the second program instance using 

the rest of the  icons in the taskbar notification area.
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2. Creation of Video Report

2.1. General Information

 Tip: g We recommend creating video report directly after the match 
has finished.

Video report is a set of AVI files with recorded fragments of the 
match. The fragments correspond to marked events.

Every marked event is assigned to several different fragments 
recorded by every camera.

Event mark
Fragment start Fragment end

Fragments of the marked event recorded 
by different cameras

...

Record by Camera 1 ......

Record by Camera 2 ......

Record by Camera N ......

All fragments have equal duration by default. User specifies 
start and end of the fragment relatively event mark location. 
Duration of every fragment can be adjusted by changing its 
start and/or end.

There is a possibility of creating a complete or a selective video 
report:

complete report is the report that includes all  ●
fragments of all marked during the match events; 
selective report is the report that includes selected  ●
fragments of the selected events.

You may output fragments in the following ways:
every fragment is output into a separate video file; ●
all fragments are output into one video file. ●
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2.2. Playlist Window
Configuration and control over video report are implemented in 
the Playlist window.

You may open the window in one of the following ways:
via the  ● Edit > Edit Playlist... menu command;
via the  ● Ctrl+P hot keys; 
 

P

Ctrl Ctrl  

via the  ●  button located on the toolbar.
The following elements are located in the Playlist window:

the list of events marked during record of the match (2); ●

6 8

7

1

3

4

5

2 10

9

11

12

preview windows to display frames of the selected  ●
event that were recorded by different cameras (1) 
(number of windows corresponds the number of 
cameras);
the  ● All button (5) to select all events in the list;
the  ● Cam 1 – Cam N buttons (N is number of cameras) (3) to 
select fragments of one or several events recorded by 
corresponding cameras;
the (4) button is used for adding of the selected event  ●
fragments to the list with video report fragments (12);
table with a list of fragments selected for output into  ●
the video report (12) (for detailed information, see 
section 2.3.);
buttons for editing of video fragments list (11): ●
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 ●  is used to open the window for adjusting 
parameters of the selected fragment;

 ●  and  are used to move selected items up or 
down;

 ●  is used to delete selected items from the list;
 ●  is used to select all items in the list;

elements to adjust borders of fragment selected in the  ●
list (12) (for more information, see section 2.6.);
the  ● Settings... button (6) is used to configure general 
fragments settings;
the  ● Export... button (7) is used to export fragments 
included to the video report list (12) to AVI files;
the  ● OK button (8) is used to close the Playlist window 
with saving of changes that were made. When the 
window will be opened again all configured setting 
of the playlist that were made during the previous 
session will be available;
the  ● Cancel button (9) is used to close the Playlist window 
without saving of configured settings.

2.3. Table with the List of Video Report Fragments
A list of video report fragments is displayed in the form of the 
table in the Playlist window.

Number of rows in the table corresponds the number of 
fragments added to the video report list. The following 
information is displayed in the table:

# ●  is index of the fragment;
Title ●  is the information on the event (its type, playing 
and daily time) and the title of the camera that 
recorded this fragment;
Frame Begin ●  displays the first fragment frame;
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Duration (sec.) ●  displays duration of the fragment;
Frame End ●  displays the last fragment frame.

2.4. Complete Video Report Output (All Events, All Fragments)
This section describes creation of video report when all 
fragments recorded by all cameras are included in it (complete 
video report).

  8 Important: Sometimes complete video report includes fragments that are 
not of great importance.

For example, the most important fragments of the Goal event 
are those recorded by cameras located near the goal where the 
puck was scored. Video report files with the same fragments but 
recorded by oppositely located cameras are usually not valuable.

Workflow:

1. Open the Playlist window using the Edit > Edit Playlist... menu 
command (for other ways of the Playlist window activation, 
see section 2.2.).

1

 If table for fragments includes a list of fragments that were 
marked, for example, during the previous program session, 
you sholud clear the table before creating video report of a 
new match. For detailed information on this issue, see step 
11 below.

2. Adjust duration of fragments included into video report by 
completing the following steps:
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1. Click Settings... (1). The Playlist Settings window appears. 

2

3

4

2. Specify time offset from the event mark time in the 
Start time offset back from event time field (2).

 

Event MarkStart time offset back  
from event time

End time offset  
from event time

Fragment

Time

Video record ......

3. Specify time offset from event time in the End time off-
set from event time field (3).

  8 Important: Let we specified start time offset back from event time 10 
seconds and end time offset from event time 5 seconds. At 
adding of the event to the list with fragments there will be 
created a new fragment. Its duration will be 15 seconds with 
10 seconds before event takes place and 5 seconds after its 
occurence.



35

5

 

All events will be marked (6).

 
6

7

4. Click All (7) to select all cameras.
In this case the Cam1 – Cam N buttons (N denotes number of 
the camera) will be outlined in green (8).

8

9

Reccurent clicking the All button results into deselecting of 
selected events.

5. Click the  button (9) to add fragments into the list of 
video report fragments.
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Information on added fragments will be displayed in the 
table (10).

10

11

 

6. When adding fragments to the table they will be 
automatically selected for being exported into video files. It 
will be marked by grey filling in the # (a) and Duration (sec) (b) 
columns.

a b

c
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If to right-click one of the strings in the table all fragments 
will be deselected except the clicked one. Click All (c) to 
select all fragments if necessary.
Edit fragments list via the buttons:

 ●  and  are used to move selected items  
up/down;

 ●  is used to delete selected items from the list;
 ●  is used to select all items in the list.

Instruction on editing of separate fragments you may find in 
section 2.6.

7. Click Export...  (11). 
The Export AVI file from Playlist window appears.

12

17

18

19

20

21

13

14

15

16

22

8. We recommended to do the following in the Export AVI file from 
Playlist window:

1. Put the marks:
Overwrite file without asking any questions ●  (17);
Export each playlist item to separate file to folder  ● (12);
Propose to open exported file or folder after exporting ●  (14);
Draw information in video frames  ● (15).
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 All other marks must be off (see the picture above).
2. Click Browse... (18).  

Specify a folder to output video report files. Then click 
ОK.  
Specified path will be displayed in the (13) field.

3. Select data for adding to the file name in the Use date 
in names of exported files list (19).

4. Click Information Settings... (20). The Video Information Set-
tings window appears.

 Put the Time from start mark (23).

23

 Close the Video Information Settings window by clicking OK.
5. Click Compression Settings... (21) in the Export AVI file from 

Playlist window.

 The Video Compression Setitngs window appears.

20

21
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24

 Select SoftLab-NSK DVCAM in the Output Format list (24). 
Then click Ok to close the window.

6. Select the Microsoft DV (standard) format in the Make 
created AVI file compatable with selected video format (Fourcc 
code) list (16).

9. Click OK (22) in the Export AVI file from Playlist window.

 Export of fragments to AVI files starts. Progress bar 
appears.

10. Window with the following request appears.

 

 Click OK if you need to open the folder, in other case – click 
Cancel.

11. Fragments list won't be automatically cleared after AVI 
exporting.

16

22



40

 Complete the following actions to clear the list if necessary:

1. Click  (26).
2. Then click  (25). 

 
25

26

12. Close the Playlist window by clicking Оk (27).

27

2.5. Selective Video Report Output
This section describes creation of video report that includes only 
some fragments specified by the user (selective video report).

Workflow:

1. Open the Playlist window using the Edit > Playlist Editor... menu 
command (for other ways of the Playlist window activation, 
see section 2.2.).

1
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2. Click Settings... (1). The Playlist Settings window appears.  
 

2

3

4

3. Specify duration of fragments in the Playlist Settings window 
by completing the following steps:

1. Specify offset back in the Start time offset back from start 
event field (2).

 

Event markStart time offset  
back from event time

End time offset from 
event time

Fragment

Time

Video record ......

2. Specify offset forward in the End time offset from event 
time field (3).

3. Click ОK (4) to close the Playlist Settings window. 
4. Select the event by clicking it in the Playlist window (6).
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6

5

7

5. Specify what records of the selected event should be added 
into report in one of the following ways:

click the  ● Cam. Х button (7) (Х denotes camera number). 
The button will be outlined in green. 
Recurring clicking the button results into fragment 
deselection. Green outline of the Cam. Х button (Х 
denotes camera number) dissapears.
click preview window (5) of the specified camera.  ●
The appropriate button will be outlined in green (7). 
Repeat clicking the window results into deselection 
of the fragment. Green outline of the Cam. Х button (Х 
denotes camera number) dissapears.

6. Click the  button (8) to add selected fragments to the 
list. Information on added fragments is displayed in the 
table (10).
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10

9

8

11

 

7. Repeat steps 3–5 to add all necessary fragments to the video 
report list.

8. Edit fragments list when necessary by using the following 
buttons (11):

 ●  and  are used to shift selected elements up and 
down;

 ●  is used to delete selected elements from the list;
 ●  is used to select all elements in the list.

To edit borders of necessary fragments, see section 2.6.

9. Click Export... (9). The Export AVI file from Playlist window 
appears.
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12

17

18

19

20

21

13

14

15

16

22

10. It is recommended to complete the following in the Export AVI 
file from Playlist window:

1. Put the marks:
Overwright file without asking any questions ●  (17);
Export each playlist item to separate file to folder  ● (12);
Propose to open exported file or folder after exporting  ● (14);
Draw information in video frames ●  (15).

 Other marks must be off (see the picture above).
2. Click Browse... (18).  

Specify a folder to output video report files in the 
appeared window. Then click ОK.

 Specified path will be displayed in the (13) field.
3. Select data for adding to the file name in the Use date 

in names of exported files list (19);
4. Click Information Settings... (20). The Video Information Set-

tings window appears.
 Put the Time from start mark (23).
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23

24

Close the Video Information Settings window by clicking OK (24).
5. Click Compression Settings... (21) in the Export AVI file from 

Playlist window.

20

21

16

22

 The Video Compression Settings window appears.

 

25

26

 Select SoftLab-NSK DVCAM in the Output Format list (25). 
Close the window by clicking ОK (26). 
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6. Select the Microsoft DV (standard) format in the Make 
created AVI file compatable with selected video format (Fourcc 
code) list (16) of the Export AVI file from Playlist window.

11. Click OK (22) in the Export AVI file from Playlist window.

 Export of fragments to AVI files starts. Progress bar 
appears.

12. The following window appears.

 

 Click OK if you need to open the folder, in other case click 
Cancel.

13. Fragments list won't be automatically deleted after 
exporting.

 Complete the following actions to clear the list :

1. Click  (28).
2. Then click  (27). 

 
27

28

14. Close the Playlist window by clicking Оk (29).

29
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2.6. Editing of Video Fragments Borders
After adding of fragments to video report list they all have 
equal duration. The application provides a possibility of 
adjusting duration of each fragment.

General workflow:

1. Select a fragment by clicking it in the table with the 
fragments list (1).  
Frame of the selected fragment will be displayed in the 
preview window (2).  
Time of the first fragment frame will be displayed in the (3) 
field and of the last frame in the (4) field.

1

2

3 4

2. Select adjustable fragment border (start/end). Button 
assigned to the selected border (Begin (5)/ End (7)) will be 
outlined by green; the first/last frame of the fragment will 
be displayed in the preview window (2). Complete one of the 
following actions to specify «Begin»:

click the  ● Begin button (5);
click  ● Frame Begin in the row with the selected 
fragment.
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2

6

5

8

7

 
Complete one of the following actions to edit «End»:

click  ● End (7). The button will be outlined in green. 
The last frame of the fragment will be displayed in 
the preview window (2);
click in the  ● Frame End (8) field in the row with the 
selected fragment.

3. Select the frame that is necessary to specify as the  
begin/end by moving on video material via the (9)–(12) 
buttons.

109 11 12

The 9 – 12 buttons for moving on video material:
(9) – left some frames; ●
(10) – left one step; ●
(11) – right one step; ●
(12) – right some frames. ●

Corresponding frames will be displayed in preview window (2) 
when moving on video material.
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3. Finish Working with the Application
The application can be closed in one of the following ways:

using the  ● File > Exit menu command;

using the  ●  button located on the application toolbar.
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3. Recording of Video Report to DVD
Recording of video report to DVD is implementing in the Playlist 
window. First create a list of fragments to be output into a video 
report.

Workflow:

1. Click DVD... (1) in the Playlist window.

1

2. The following window appears. Click OK (2) to continue 
working.

2

3. The Preparing DVD creation window will be opened.
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4. The SL DVD Writer window appears then.

5

6

3

4

The following elements are located in this window:
elements of the  ● Game group (3) are used to input 
information on the game (names of the teams, place of 
competition etc.) and to control displaying of this data 
in the main DVD menu;
elements of the  ● Disc appearance group (4) are used to 
configure a background of DVD menu;
window for displaying of made configurations of DVD  ●
menu (5);
elements of the  ● DVD menu group (6) are used for 
configuring of DVD menu options.

The following information is displayed in the main DVD menu:
information on the game (7) (user-specified); ●
menu options that are created automatically with the  ●
information about game fragments selected for being 
recorded on the DVD:

list of events (8); ●
list of periods (9). ●

7

8 9
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5. At opening the window data entered during the previous 
program session will be displayed in the Game group fields.

2

3

4

7

5 6

8

9

1

Enter information on the current game:
in the  ● Date and comments group (1):

click (2) to change date of the game by selecting it  ●
in the appeared window;
information on place of the match in the (3) field. ●

information in the  ● Participants group (4) is divided into 
2 columns: Home (5) (information on a home team) and 
Guests (6) (information on a guest team):

name of the team in the  ● Team field (7);
name of the city in the  ● From field (8);
Score ●  (9) denotes a number of scored goals by the 
team.

Design of the text can be specified by the following buttons:

  ●  is used to specify the name, style and size of a 
font;

  ●  is used to specify color of a background;

  ●  is used to specify color of a font.
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6. Configure menu background and DVD appearance via 
elements located in the Disc appearance (1) and the DVD 
menu (2) groups.

3

1
2

7. Click Create DVD (3) when all necessary settings are 
configured.

8. The Image of DVD was created window appears. 
Select Burn DVD... (4).  
Then click Execute (5). 

5

4

9. The Astroburn Lite application window appears.

 

10. Put a blank DVD in the drive.
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11. Click Start Burn (1) in the Astroburn Lite application window.

1

3

2

12. Burning of the DVD starts. Indicator (2) displays a progress 
of burning.

13. Close the apllication via the  button (3) when burning is 
completed.

14. Switch back to the Image of DVD was created window.  

54

Click Execute (4) to repeat recording of DVD and then repeat 
steps 10–13.
Click Close (5) to close the window.

15.  Close the SL DVD Writer window via the  button in the title 
bar.

16. Click Ок (6) to close the Playlist window.

6
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4. Finish Working with the FDReferee Application
The application can be closed in one of the following ways: 

using the  ● File > Exit menu command;

using the  ●  button located in the title bar.
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RPMStorageManager – Working with Storages

General Information

The «Forward Referee» standard system includes 8 video 
cameras and 8 storages where recorded material is stored. 
There is a separate storage for video record from each camera.

A storage is a set of files located on PC hard discs, logically a 
storage is a continuous cyclical data array.

Every storage has its own name. Cam1, Cam2, ..., CamN (N is the 
number of used cameras) are default names of storages.

All storages used when recording of one game have the same 
capacity. Capacity is specified by the user who specifies 
duration of record and data rate (Kbyte/sec).

Filling of storage by data is circled. In the limits of the specified 
duration data is recorded successively. If duration of a record 
exceeds storage volume then the most outdated information will 
be overwritten by the current one.

Sometimes it is necessary to restore match record made several 
days/weeks/months ago when working with the Forward 
Referee system. The RPMStorageManager application is used 
for these cases to store a record in the archive and to restore it 
when necessary for recurrent review, creation of video report 
etc.
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Launch and Exit From the RPMStorage Manager Application

The application can be launched in one of the following ways:
via  ● Start > Forward Referee > Storage Manager;
via program shortcut  ●

 

The main application window appears.

Click  to close the application.
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General Workflow

1. Creation of storages

1. Check what disks are selected for storages in the Hard disks 
field (1).

1 2

The C disc is used as the system one. We recommend not 
to use this disc for storing of video records. Specify another 
disc if С:\ is displayed in the Hard disks information field. To 
do this:

1. Click Settings... (2). 
The Hard Disks Selection window appears.

3

4

5
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2. Select D:\ in the First disk list (3) and E:\ in the Second 
disk list (4).

3. Close the window by clicking OK (5).
4. Specified configurations (6) will be displayed in the 

Hard disks field of the main application window.

6

7

2. Click Create... (7).
The Storages Archiving window appears if created earlier 
storages were not moved to the archive. 
 

 
 
Click No to delete current storages. The window will be 
closed. Click Yes to save storages in archive. The Archiving 
window appears. 
 

 
 
Specify name of the archive where records from storages 
will be removed in the Name field. Current date is the name 
of the archive by default. You may add, for example, names 
of teams that participated in recorded match. 
Click OK and the window will be closed.

3. The Storages Creation window appears.
Set period of time (hh:mm) in the Duration field (8) that will 
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be enough to save the game to the storage, 3 hours is 
advisable value.
Default value (3500 Kbyte/sec) is specified in the Data rate field (9). 
We recommend you not to change this value. 

8

9

10

 
Click OK (10). The window will be closed.

4. Eight storages under the Cam1, Cam2, Cam3, ..., Cam8 names 
will be created.
The following message appears after creating of storages.

Click OK to close the window.

5. The following information will be displayed in the main 
application window:

name of the archive (1) in the  ● Archive table if earlier 
created storages were moved into the archive;
information on duration of created storages and data  ●
rate in the (2) fields;
information on number of storages and its data in the  ●
(3) field.
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1

3

2

2. Moving of data from storages to archive
Information on existing storages is displayed in the (1) field.

1

Complete the following steps to move records from storages into 
archive:

1. Click Archive... (2) in the main application window.
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2

2. The Archiving window appears.

3

4

3. Specify name of the archive in the Name field where records 
from storages will be removed. Current date is the name of 
the archive by default. You may add, for example, names of 
teams that participated in recorded match.

4. Click OK (4). The window will be closed.

5. Name of the created archive (5) will be displayed in the Ar-
chive area of the main application window.

5

  8 Important: There is no any data compression and other transformations when 
moving storages in archive.
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3. Deleting of archive
1. Select archive by clicking it (1) in the Archive list in the main 

application window.

2. Click Delete (2).

1

2

4. Restoring of video records from archive to storages
Restoring of record from archive is useful in some cases, e.g. 
when it is necessary to review some disputable moments of a 
game or to create video report one more time.

Complete the following steps to restore record from archive:

1. Select archive by clicking it in the Archive list of the main 
application window.

2. Click Restore.

3. The following window appears if there are video records in 
current storages at the moment. 
 

Data will be transmitted from the archive to storage.The 
following window occurs then.

4. Click Yes to view storages.
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Advisable Workflow for Preparing of a New Game

1. Launch the RMPStorageManager application.

2. Delete archives of expired games. Common requirement is 
to store recorded games that took place during 2 last weeks.

3. Move record of the last game into the archive.

4. Create storages for recording of a new game.

5. Close the application.



Useful Links

© SoftLab–NSK

ForwardT Software set: description, download, documentation, solutions
http://www.softlab-nsk.com/forward/index.html

Support 
e-mail: forward@sl.iae.nsk.su

  forward@softlab-nsk.com

  forward@softlab.tv

Forum 
http://www.softlab-nsk.com/forum (currently available in Russian only)

Documentation for more information:

FDReplay VideoIn. Multichannel AV capture to storages.

Translation from
June 7, 2011

http://www.softlab-nsk.com/forum
http://www.softlab-nsk.com/forward/docs/en_rm_videoin.pdf
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